
Copyright © 2015 Cybercom Software

User Guide



MessageSender 52

Copyright © 2015 Cybercom Software

Table of Contents

Foreword 0

Part I Introduction 4

Part II Installation 4

................................................................................................................................... 51 Upgrading Previous Versions of MessageSender

................................................................................................................................... 52 Installing MessageSender

................................................................................................................................... 113 Installing the MessageSender Service

Part III MessageSender Startup 12

................................................................................................................................... 121 Trial Period

................................................................................................................................... 132 PhonePad Database Location

Part IV Configuring MessageSender 14

................................................................................................................................... 141 Step 1 - Setting Up the Data Connection

................................................................................................................................... 152 Step 2 - Email Settings

.......................................................................................................................................................... 17Authentication 

................................................................................................................................... 183 Step 3 - SMS Settings

................................................................................................................................... 194 Step 4 - Message Processing

Part V Message Templates 20

................................................................................................................................... 201 Email Message Templates

................................................................................................................................... 252 SMS Message Templates

Part VI Managing MessageSender 28

................................................................................................................................... 281 About MessageSender

................................................................................................................................... 292 Menus

................................................................................................................................... 303 Toolbar

................................................................................................................................... 314 Sidebar

................................................................................................................................... 315 Activity Log

................................................................................................................................... 326 Message Queue

................................................................................................................................... 337 General Settings

................................................................................................................................... 358 Email Settings

.......................................................................................................................................................... 37SMTP Authentication 

................................................................................................................................... 379 SMS Settings

.......................................................................................................................................................... 38Clickatell 

.......................................................................................................................................................... 40SMS Global 

.......................................................................................................................................................... 42Pushover 

................................................................................................................................... 4410 MessageSender Service Status



3Contents

3

Copyright © 2015 Cybercom Software

................................................................................................................................... 4511 File Location

................................................................................................................................... 4612 Purchasing MessageSender

................................................................................................................................... 4613 Licensing MessageSender

Part VII SMS Gateway Providers 47

................................................................................................................................... 471 SMS Global

................................................................................................................................... 502 Clickatell

................................................................................................................................... 523 Pushover

Part VIII Version History 55

Index 58



MessageSender 54

Copyright © 2015 Cybercom Software

1 Introduction

Welcome to MessageSender.  

PhonePad has a feature called Automatic Message Forwarding.  This enables users to have their
PhonePad phone and text messages forwarded to them when they're not in the office. Whether your
organization has users that are on-the-road, working from home, or otherwise out of the office, with
Automatic Message Forwarding these people can get their messages wherever they are.

MessageSender is an add-on to PhonePad that can automatically forward PhonePad messages (both
phone and text) to email addresses and mobile/cell phones.  It is ideal for users on-the-road, working
from home or who are otherwise out of the office.

MessageSender consists of two applications: the Windows service and the Manager application.  The
MessageSender service performs the actual work of sending the messages via email or SMS, while
MessageSender Manager is used to configure and manage MessageSender.
 
 

 

2 Installation

Installing MessageSender is a simple process.  Just run the MessageSender setup program and follow
the steps.  Both the MessageSender Windows service and the MessageSender Manager application will
be installed.

IMPORTANT: MessageSender should be installed on the same server or Host computer that the
PhonePad database is located on.  The MessageSender service runs under the system account
and, due to Windows restrictions, it will be unable to access drives located on another computer.
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Only one copy of MessageSender needs to be installed on your network.

2.1 Upgrading Previous Versions of MessageSender

If you already have a previous version of MessageSender installed, you will first need to stop and
uninstall the MessageSender service before installing the new version.  You can do this by running 
MessageSender Manager and then selecting Uninstall Service from the Tools menu.

Please note that you may need administrator privileges to do this.

2.2 Installing MessageSender

Let's get started.  The first step is to download MessageSender 5 from the website (http://www.
cybercom-software.com/messagesender) and then follow these instructions for installing
MessageSender:

1. Run MessageSender5Setup.exe.

2. You may be prompted with a Security Warning.  Click Run.
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3. The MessageSender setup program Welcome screen will be displayed.

4. Click Next to continue. 

5. The License Agreement screen will be displayed.  Please read the agreement before continuing.
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6. You will need to select the I accept the agreement option before you can continue. Click Next when
you are ready.

7. An Information screen will be displayed. Click Next when you are ready.

8. Specify the Destination Location (the folder you want to install MessageSender in), or use the
default location (C:\Program Files\MessageSender5).
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9. Click Next to continue

10.Specify a Start Menu Folder or use the default one.

11.Click Next to continue.

12. If you want a Desktop icon or a Quick Launch icon created for MessageSender Manager, select
these options.
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13. Click Next to continue.

14. You're now ready to install MessageSender.  

15. Click Install to begin.
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16. That's it.  MessageSender has been installed on your system.

17. Click Finish to complete the process.
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2.3 Installing the MessageSender Service

Although the MessageSender files have been installed on your system, you still need to install the
Windows service as a separate step.  Fortunately this is easy to do with MessageSender Manager and
no technical knowledge is required.

1. Run MessageSender Manager.

2. Select Install Service from the Tools menu.
 

 

3. You should see a DOS or command window appear briefly.  If you have the MessageSender service
already installed then you will probably get an error message and will need to uninstall it first.

If you have the appropriate access rights, you can run the Windows Services app (Services.msc) to
see if the MessageSender service is running.
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Important Notes

You may need administrator rights to install the MessageSender service.  If you get an error
message (eg. Access Denied) when installing the service, you can try the following:

1. Go to the MessageSender folder.
2. Right-click on MessageSenderInstall.cmd.
3. Select Run as Administrator from the popup menu.

If the above doesn't work either, then you will need someone with a system administrator account to
login to the server or Host PC you are on and perform the install for you.

3 MessageSender Startup

When you start MessageSender, especially for the first time, the following screens may be displayed.

3.1 Trial Period

MessageSender has a free 30-day trial period.  This means that you can try MessageSender for 30
days free-of-charge with all functionality enabled.

Once trial period has ended you will still be able to open MessageSender Manager, but no messages
will be sent.

When you open MessageSender during the trial period, the following screen will be displayed.

     

The screen will show you how many days left you have of your 30 day trial.

The screen has the following buttons:

Continue Click the Continue button to continue your trial.
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Purchase Opens your default web browser and takes you to the MessageSender
order page.

License Click this button to enter your license details.  MessageSender will be
changed from a trial version to a fully licensed version.

Quit Close MessageSender Manager.

3.2 PhonePad Database Location

If you haven't told MessageSender the location of your PhonePad database (which you wouldn't have
the first time you open MessageSender Manager) this screen will be displayed.

       

1. You can type in the location of your PhonePad data folder, or you can select it by clicking the folder
button (next to the Data Folder field).

2. If you're not sure where the data folder is, click the Find Database button.  MessageSender
Manager will attempt to locate the folder for you.

     

3. In the above example, two data folders were found (there should normally be only one but the
example was done on a test machine).  Select the correct folder then click OK.
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4. If you check the other button next to the Data Folder field (the one with the tick/check mark),
MessageSender Manager will confirm that the folder does contain the PhonePad data files.

      

5. Click OK to save this setting.

IMPORTANT: The MessageSender service is a Windows service that runs under the system account. 
This means that it cannot access a network drive.  The PhonePad data folder must be located on a drive
that is local to the service.  If the PhonePad data folder is located on a network drive, it will also map to
a local drive on the server.  You will need to find out where that is.

If you are running MessageSender on a Host PC on a Peer-to-Peer network then you don't need to
worry about this. Make sure though that the PhonePad data folder is not on a NAS device.

4 Configuring MessageSender

Before MessageSender can start forwarding messages, you will need to configure it using 
MessageSender Manager.  Run MessageSender Manager and then follow the steps in this section.

4.1 Step 1 - Setting Up the Data Connection

1. Select General Settings from the sidebar.

2. Under PhonePad Database Connection, select or enter the PhonePad Data Folder (1).

3. Validate the PhonePad data folder by clicking the small button with the tick/check mark (2).
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4. Click Save Settings.

4.2 Step 2 - Email Settings

If you want to automatically forward messages via email, you will need to configure the following
settings:

1. Select Email Settings from the sidebar.

2. Under SMTP Server Settings, enter the details of your mail server.  You will need to specify a valid
email account (and password) to send the messages through.  

3. If you are using an internal mail server then you may not need to provide a username and password.
In this situation, check the Username and Password Not Required checkbox.
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4. Under Email Templates, you will need to specify templates to use when sending the messages.  You
can either use the default templates or create your own (see Message Templates for more
information).

5. Under Sender Details, you will need to enter the details of the email address you will be using to
send the emails.  Enter a Sender Name for the email account (eg. PhonePad, or whatever you want)
and a valid email address for Sender Email.  The email address you use should be the address for
the account specified under SMTP Server Settings, otherwise you may get relay errors.  You can
simply click the green arrow button to copy the Account Name to the Sender Email setting if they
are the same.

6. Under Email Subject, select what data should be used for the subject of the email:

Use Message Subject - The Subject field of the message will be used for the email's subject. 
Use Custom Subject - The text you enter in this field will be used for the email's subject.
Use Field for Subject - Data from the selected field will be used for the email's subject.

7. If the default email authentication settings don't work with your mail server then you will need to click
the Authentication button to change the settings.

8. Click Save Settings.

Important Note

Your email Account Name is typically your email address, eg. jane@somewhere.com.  However, some
mail servers require a slightly different formatting for the Account Name, by using a plus sign (+)
instead of an at symbol (@).  So for example, it would be jane+somewhere.com instead of
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jane@somewhere.com. 

4.2.1 Authentication

Depending on your mail server, it may or may not require secure connections. If MessageSender is
unable to successfully connect to your mail server, try switching SSL Connection to the opposite
setting.

To access this option, click the Authentication button on the Email Settings screen.

SSL Connection Connect to the mail server using a secure connection.

You can test the email settings by clicking the Test button, then clicking Do Test to send a test email.

Here is an example of a successful test.  You will receive a test email if the test was successful.

If you have difficulties getting MessageSender to work with your mail server, Cybercom Software
Support can assist with this.
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4.3 Step 3 - SMS Settings

If you want to automatically forward messages via SMS text message, you will need to configure the
following settings:

1. Select SMS Settings from the sidebar.

2. Under SMS Gateway Provider, select the SMS provider you will be using with MessageSender to
send SMS messages.

3. Under SMS Message Templates, you will need to specify templates to use when sending the
messages.  You can either use the default templates or create your own (see Message Templates for
more information).

4. When you select an SMS Gateway Provider, the appropriate tab will be enabled.  Click on the tab
for the provider you selected.

5. Enter the details provided by your SMS Gateway Provider, ie. Username, Password and Account
ID.  If you don't have an account, you can click on the link (it has a green star icon next to it) to go to
the provider's website and open an account.
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6. Click Save Settings.

Important Note

The SMS Gateway providers are not associated with Cybercom Software - they are 3rd party
organizations.  We have no control over or access to your account with them.

4.4 Step 4 - Message Processing

1. Select General Settings from the sidebar.

2. Check the Active checkbox to activate message processing.

3. Check the Process Emails checkbox if you want messages forwarded via email.
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4. Check the Process SMS checkbox if you want messages forwarded via SMS messages.

5. Set how often you want MessageSender to check messages to process.  Every 5 minutes is the
default.

6. Click Save Settings.

5 Message Templates

One of the major improvements with MessageSender 5 is the ability to completely customize the format
of the messages sent by both email and SMS.  MessageSender comes with default templates for each
of the different message types:

EmailPhoneMessageTemplate.tem
EmailTextMessageTemplate.tem
SMSPhoneMessageTemplate.tem
SMSTextMessageTemplate.tem

You can use these as is, modify them, or create your own.

If you inadvertently delete the default message templates, you can easily re-create them by selecting 
Recreate Email Templates or Recreate SMS Templates from the Tools menu.

5.1 Email Message Templates

MessageSender Manager includes a built-in editor for creating and editing email message templates. 
To open the editor, click on the Templete Editor button - see screenshot below:
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The Template Editor will be displayed (as shown below).  If a message template was specified in the
message template field then the Template Editor will automatically open the template for editing.  You
have a number of choices:

Edit the template and save it, overwriting the existing one (use Save).
Edit the template and save it as a new template (use Save As).
Create a new template from scratch by clicking the New button.

A message template is made up of static text and tags (indicated with <>).  For example, in the above
screenshot "To:" is static text while "<recipients>" is a tag.  When a message is processed, the tags
are replaced with actual data from PhonePad messages, while the static text is ignored.  

In the same screenshot you can see one of the default email message templates that is included with
MessageSender. Virtually every tag is used in this example.  To modify the template, simply change or
remove the static text and tags you don't want.

The Message Type drop-down list is used to indicate the type of messages the template is to be used
for.  Tags can be inserted by selecting them from the Template Tags drop-down list and then clicking
the Insert button.

Creating a New Template

1. To create a new message template, click on the New button on the toolbar.  

2. You can add any static text you want to the message area and format it in any way you desire.  
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3. To add message tags, position the cursor in the message area where you want the relevant message
data to appear.  Next, select the appropriate tag from the Template Tags drop-down list, and click
the Insert button.

You can save the template by clicking the Save button.  You will be prompted for a filename.

Editing an Existing Template

1. If a message template was specified in the message template field then the Template Editor will
automatically open the template for editing.  You can edit this template or open another template by
clicking the Open button.

2. Editing a template is the same as creating a new template.You can add any static text you want to the
message area and format it in any way you desire.  

3. To add message tags, position the cursor in the message area where you want the relevant message
data to appear.  Next, select the appropriate tag from the Template Tags drop-down list, and click
the Insert button.

4. To save your changes, click the Save button.

Template Tags

The Template Tags that are available for creating and editing message templates is dependant on the
type of message selected.
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Phone Message

<caller> Name of the person calling.

<cametoseeyou> Displays an [X] if this is true.

<cametoseeyoulabel> Displays "Came to See You" unless you
have changed it using the LabelEditor
utility.

<calldetails> This will be either "Phoned", "Returned
Your Call" or "Came to See You".  If
you have changed the message labels
then those labels will be displayed
instead.

<callaction> This will be either "No Action Required",
"Please Phone", "Will Phone Again",
"Will Drop By Again", "Wants to See
You" or "Will Be In At".  If you have
changed the message labels then those
labels will be displayed instead.

<date> Date of the message.

<from> The caller's organization.

<message> The actual text of the message.

<messagetitle> By default this is "While You Were Out",
unless you have changed it using the 
LabelEditor utility.

<noaction> Displays an [X] if this is true.

<noactionlabel> Displays "Came to See You" unless you
have changed it using the LabelEditor
utility.

<phone> The caller's phone number.

<phoned> Displays an [X] if this is true.

<phonedlabel> Displays "Came to See You" unless you
have changed it using the LabelEditor
utility.

<pleasephone> Displays an [X] if this is true.

<pleasephonelabel> Displays "Came to See You" unless you
have changed it using the LabelEditor
utility.

<recipients> Lists all users the message was sent to.

<returnedcall> Displays an [X] if this is true.
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<returnedcalllabel> Displays "Came to See You" unless you
have changed it using the LabelEditor
utility.

<sender> The person who recorded the message.

<subject> The subject of the message.

<time> Time of the message.

<urgent> Indicates whether the message is urgent
or not.

<wantstoseeyou> Displays an [X] if this is true.

<wantstoseeyoulabel> Displays "Came to See You" unless you
have changed it using the LabelEditor
utility.

<willbeinat> Displays an [X] if this is true.

<willbeinatlabel> Displays "Came to See You" unless you
have changed it using the LabelEditor
utility.

<willbeinattext> The time the user will be in.

<willdropby> Displays an [X] if this is true.

<willdropbylabel> Displays "Came to See You" unless you
have changed it using the LabelEditor
utility.

<willphoneagain> Displays an [X] if this is true.

<willphoneagainlabel> Displays "Came to See You" unless you
have changed it using the LabelEditor
utility.

Text Message

<date> Date of the message.

<message> The actual text of the message.

<recipients> Lists all users the message was sent to.

<sender> The person who recorded the message.

<subject> The subject of the message.

<time> Time of the message.

<urgent> Indicates whether the message is urgent
or not.
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5.2 SMS Message Templates

MessageSender Manager includes a built-in editor for creating and editing SMS message templates. 
To open the editor, click on the Template Editor button - see screenshot below:

The Template Editor will be displayed (as shown below).  If a message template was specified in the
message template field then the Template Editor will automatically open the template for editing.  You
have a number of choices:

Edit the template and save it, overwriting the existing one (use Save).
Edit the template and save it as a new template (use Save As).
Create a new template from scratch by clicking the New button.

A message template is made up of static text and tags (indicated with <>).  For example, in the above
screenshot "from:" is static text while "<from>" is a tag.  When a message is processed, the tags are
replaced with actual data from PhonePad messages, while the static text is ignored.  

In the same screenshot you can see one of the default email message templates that is included with
MessageSender. Virtually every tag is used in this example.  To modify the template, simply change or
remove the static text and tags you don't want.

The Message Type drop-down list is used to indicate the type of messages the template is to be used
for.  Tags can be inserted by selecting them from the Template Tags drop-down list and then clicking
the Insert button.
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SMS messages are generally limited to 160 characters per message.  The SMS Template Editor
displays how many characters you have left when creating or editing a template.  Remember that the
tags are replaced with real data when MessageSender processes messages to send, so it is highly
likely that the tags will take up more space once they have been expanded with data.

Creating a New Template

1. To create a new message template, click on the New button on the toolbar.  

2. You can add any static text you want to the message area and format it in any way you desire.  

3. To add message tags, position the cursor in the message area where you want the relevant message
data to appear.  Next, select the appropriate tag from the Template Tags drop-down list, and click
the Insert button.

You can save the template by clicking the Save button.  You will be prompted for a filename.

Editing an Existing Template

1. If a message template was specified in the message template field then the Template Editor will
automatically open the template for editing.  You can edit this template or open another template by
clicking the Open button.

2. Editing a template is the same as creating a new template.You can add any static text you want to the
message area and format it in any way you desire.  

3. To add message tags, position the cursor in the message area where you want the relevant message
data to appear.  Next, select the appropriate tag from the Template Tags drop-down list, and click
the Insert button.



Message Templates 27

Copyright © 2015 Cybercom Software

4. To save your changes, click the Save button.

Template Tags

The Template Tags that are available for creating and editing message templates is dependant on the
type of message selected.  SMS messages have a reduced sub-set of the email message template tags.
 They are designed to use as little space as possible.

Phone Message

<caller> Name of the person calling.

<calldetails> This will be either "Phoned", "Returned
Your Call" or "Came to See You".  If
you have changed the message labels
then those labels will be displayed
instead.

<callaction> This will be either "No Action Required",
"Please Phone", "Will Phone Again",
"Will Drop By Again", "Wants to See
You" or "Will Be In At".  If you have
changed the message labels then those
labels will be displayed instead.

<date> Date of the message.

<from> The caller's organization.

<message> The actual text of the message.

<phone> The caller's phone number.

<sender> The person who recorded the message.

<subject> The subject of the message.

<time> Time of the message.

<urgent> Indicates whether the message is urgent
or not.
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Text Message

<date> Date of the message.

<message> The actual text of the message.

<sender> The person who recorded the message.

<subject> The subject of the message.

<time> Time of the message.

<urgent> Indicates whether the message is urgent
or not.

6 Managing MessageSender

The MessageSender Manager application is used to manage the MessageSender service, as the
service doesn't have its own user interface.  MessageSender Manager must be run from a local drive on
the server or Host PC.  It cannot be run from a network drive.  You can also run it by accessing the
server or Host PC via Windows Remote Desktop or other remote software.

6.1 About MessageSender

Click on the About button on the toolbar, or select About from the Help menu.

The About screen will then be displayed.

     

The About screen displays:

The version of MessageSender you are using.
Copyright information.
Who the software is licensed to.
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6.2 Menus

You can access most of MessageSender Manager's features via the menus, toolbar or sidebar.

File menu

Activity Log Displays the MessageSender Activity Log.

Message Queue Displays the MessageSender Message Queue.

General Settings Displays the General Settings screen.

Email Settings Displays the Email Settings screen.

SMS Settings Displays the SMS Settings screen.

Save Settings Save any changes you have made.

Exit Exits MessageSender Manager.

Tools menu

Install Service Installs and starts the MessageSender
Windows service,

Uninstall Service Stops and uninstalls the MessageSender
Windows service.

Clear Queue Clears all messages from the message queue.
The cleared messages will not be sent.

Remove Message Removes the selected message from the
queue.

Remove Email Messages Removes all messages scheduled for
forwarding via email from the queue.

Remove SMS Messages Removes all messages scheduled for
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forwarding via SMS text message from the
queue.

Recreate Email Templates Recreates the default email templates.

Recreate SMS Templates Recreates the default SMS templates.

Help menu

Help Displays online help.

Check for New Version Contacts the Cybercom Software web server
and checks to see if there is a newer version
available.

Support Opens the Support web page.

Suggestions Opens the online Suggestion Box system
where you can send suggestions on what new
features you would like to see.

Purchase Opens the MessageSender order page. This
option won't appear if you have already
purchased MessageSender.

License Opens the License screen so you can license
your copy of MessageSender.

About Displays information about MessageSender
Manager.

6.3 Toolbar

You can access most of MessageSender Manager's features via the menus, toolbar or sidebar.

File menu

Activity Log Displays the MessageSender activity log.

Message Queue Displays the MessageSender message queue.

General Settings Displays the General Settings screen.

Email Settings Displays the email settings screen.

SMS Settings Displays the SMS settings screen.

Save Settings Save any changes you have made.
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Cancel Cancels any changes you have made.

Exit Exits MessageSender Manager,

About Displays information about MessageSender
Manager.

Help Displays online help.

6.4 Sidebar

You can access most of MessageSender Manager's features via the menus, toolbar or sidebar.

Activity Log Displays the MessageSender activity log.

Message Queue Displays the MessageSender message queue.

General Settings Displays the General Settings screen.

Email Settings Displays the email settings screen.

SMS Settings Displays the SMS Settings screen.

6.5 Activity Log

The Activity Log screen provides a convenient way to view the log files created by the MessageSender
service.  A new log file is automatically created each day.  You can select a log using the list on the
right.
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The log files contain the following information:

Details of messages forwarded by MessageSender.
Errors received from mail servers or SMS gateways.
Problems with the MessageSender configuration.

If you find that messages are not being forwarded, check the Activity Log for any errors.

The Refresh button will reload the select log file.  If the Auto Refresh checkbox is checked, the
message queue list will be automatically refreshed every 5 seconds.

The Delete button can be used to delete the selected activity log, or all activity logs.

6.6 Message Queue

The Message Queue displays a list of all messages waiting in the forward queue.  As messages are
processed by the MessageSender service, they will be cleared from the queue.
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Clicking the Refresh button will update the message queue list.  If the Auto Refresh checkbox is
checked, the message queue list will be automatically refreshed every 5 seconds.

Messages can be cleared from the queue (ie. deleted) by selecting Clear Queue from the Tools menu.

6.7 General Settings

The General Settings screen contains settings relevant to the general operation of the MessageSender
service and MessageSender Manager.
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Message Processing

Active When checked, the MessageSender service will process
messages in the message queue.

Process Emails When checked, the MessageSender service will process
messages that are queued to be sent via email.

Process SMS When checked, the MessageSender service will process
messages that are queued to be sent via SMS.

Process Every x Minutes Determines how frequently the MessageSender service should
check for messages to process.  The default is every 5
minutes.

Activity Log

Detailed Log When checked, the activity log will display connection
information, authentication responses, etc.

Only keep the last x files When checked, MessageSender will automatically delete older
activity log files.  You can specify the number of activity logs to
retain.

PhonePad Database Connection

PhonePad Data Folder Specifies the location of the PhonePad database.  The
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MessageSender service will not be able to process messages
unless this folder is specified.

Date and Time Settings

Status Bar Specifies the date and time format to display in the status bar.

Message Log Specifies the date and time format to use in the message log.

Folders

Activity Log File Folder Specifies the location of the Activity Log files. 
MessageSender Manager should automatically detect the
correct folder so it is recommended you don't change this
setting.

Temporary File Folder Specifies the location of a temporary folder that is used by the
MessageSender service.  By default, this setting should be
blank.  It is recommended you don't change this setting.

6.8 Email Settings

The Email Settings screen contains all settings relating to forwarding PhonePad messages by email.
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SMTP Server Settings

These settings are required if you want MessageSender to forward your PhonePad messages by email.

SMTP Server This is the Internet address of your mail server, eg. mail.
yourcompany.com or smtp.yourcompany.com.

SMTP Port This is the port your mail server expects you to communicate
on.  This is usually port 25 (but not always).

Account Name This is the email account you want MessageSender to use. 
You could use an existing account or set up a special account
for MessageSender (recommended).

Some mail servers use "+" in place of "@" for the account
name (whereas the email address uses '@').  For example,
phonepad+mycompany.com instead of
phonepad@mycompany.com.

Account Password This is the password for the email account.

Confirm Password This is the same password as above.  As the password is
masked when you enter it, this is to confirm that you have
entered the password correctly.

Authenticate Click the Authenticate button to display the SMTP
authentication screen.

Test Click the Test button to test your mail server and authentication
settings.

Email Templates

MessageSender uses templates for sending emails.  The templates specify the format of the emails and
the data that needs to be included.  Default templates are included - if these don't meet your
requirements then you customize these or create your own.

Any changes you have made to message labels (using the LabelEditor utility) will be included in the
emails.

Phone Message Template This is the template MessageSender uses for sending
PhonePad phone messages via email.

Text Message Template This is the template MessageSender uses for sending
PhonePad text messages via email.

Sender Details

These are the details of the sender name and email address that MessageSender will be using to send
the emails.
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Sender Name The Sender Name can be any name you choose, eg.
PhonePad.

Sender Email In most cases the Sender Email should be the same email
address used under SMTP Settings, otherwise you may get
relay errors from your mail server.

Email Subject

This setting tells MessageSender what it should use for each email's subject.

Use Message Subject The Subject field of the message will be used for the email's
subject.

Use Custom Subject The text you enter in this field will be used for the email's
subject.

Use Field for Subject Data from the selected field will be used for the email's subject.

6.8.1 SMTP Authentication

Generally you don't need to worry about which authentication methods your mail server requires. 
However your SMTP server may have specific authentication requirements in regards to secure
connections.  

The SMTP Authentication screen allows you to configure MessageSender to use SSL connections or
not.

To open the SMTP Authentication screen:

1. Select Email Settings from the sidebar.

2. Click on the Authentication button.

3. Check the SSL Connection check box if your mail server requires a secure connection, or uncheck
it if it doesn't.

6.9 SMS Settings

The SMS Settings screen contains all settings relating to forwarding PhonePad messages by SMS.
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Using the drop-down menu, select the SMS Gateway you want to use.

SMS Gateway Provider

SMS Gateway This is the SMS Gateway Provider MessageSender will be
using to send PhonePad messages via SMS.  You will need an
account with the selected provider.

SMS Message Templates

Phone Message Template This is the template MessageSender uses for sending
PhonePad phone messages via SMS.

Text Message Template This is the template MessageSender uses for sending
PhonePad text messages via SMS.

6.9.1 Clickatell

You will need to complete the settings on this screen if you are using Clickatell to send PhonePad
messages by SMS.  

If you don't have an account with Clickatel, you can open one by visiting their website.  Details are
available here.
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Account Details

These are the details of the sender name and email address that MessageSender will be using to send
the text messages.

Username This is the username for your Clickatell account.

Password This is the password for your Clickatell account.

Confirm Password This is the same password as above.  As the password is
masked when you enter it, this is to confirm that you have
entered the password correctly.

Account ID This is the Account ID provided by Clickatell.

HTTP API ID You will be given an API ID for HTTP.

Sender ID Depending on where you are located, you may not need to
provide this information. If you are located in the US, you
would normally have to enter the cell phone number you have
registered with Clickatell.

Gateway Settings

These are the details of the sender name and email address that MessageSender will be using to send
the emails.
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Gateway URL This is the Internet link that MessageSender uses to
communicate with the Clickatell's system.  Don't change this
unless you are advised to by Support.

Clickatell Website Clicking this link to take you to the Clickatell website.

Testing Your Settings

Click the Test button to test your Clickatel settings.  The following screen will be displayed:

Enter the phone number for your cell/mobile phone, including the country code.  A default message will
also be displayed, which can be changed as well.  Click the Send button to send a test SMS text
message.  If your settings are correct, and MessageSender Manager successfully passes the message
through your firewall, you should receive a text message on the mobile/cell phone number.

6.9.2 SMS Global

You will need to complete the settings on this screen if you are using SMS Global to send PhonePad
messages by SMS.

If you don't have an account with SMS Global, you can open one by visiting their website.  Details are
available here.
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Account Details

These are the details of the sender name and email address that MessageSender will be using to send
the text messages.

Username This is the username for your SMS Global account.

Password This is the password for your SMS Global account.

Confirm Password This is the same password as above.  As the password is
masked when you enter it, this is to confirm that you have
entered the password correctly.

Account ID This is the Account ID provided by the SMS Global.

Test Click the Test button to set you account settings.  If
successful, you should receive an SMS text message on your
mobile/cell phone.

Gateway Settings

These are the details of the sender name and email address that MessageSender will be using to send
the emails.

Gateway URL This is the Internet link that MessageSender uses to
communicate with the SMS Global's system.  Don't change this
unless you are advised to by Support.
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SMS Global Website Clicking this link to take you to the SMS Global website.

Testing Your Settings

Click the Test button to test your SMS Global settings.  The following screen will be displayed:

This screen inserts your Account ID by default, which is usually your registered mobile/cell phone
number.  You can change this if you like.  A default message will also be displayed, which can be
changed as well.  Click the Send button to send a test SMS text message.  If your settings are correct,
and MessageSender Manager successfully passes the message through your firewall, you should
receive a text message on the mobile/cell phone number.

6.9.3 Pushover

Although not really an SMS gateway, Pushover performs a similar function.  Message recipients will
need to have the Pushover apps installed on their iOS or Android device.  One of the advantages of
using Pushover is that you can send messages to any mobile device that has an Internet connection
(eg. phones and tablets).  The device doesn't have to be a phone..

You will need to complete the settings on this screen if you are using Pushover to send PhonePad
messages to mobile devices.

If you don't have an account with Pushover, you can open one (it's free) by visiting their website.  
Details are available here.
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Account Details

These are the details of the sender name and email address that MessageSender will be using to send
the text messages.

Application Key This is the Application Key in your account.  You will need to
register MessageSender as an application under your
account.

User Key This is the User Key you get when you open an account with
Pushover.

Testing Your Settings

Click the Test button to test your Pushover settings.  The following screen will be displayed:
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You will need to enter a Device Name.  This is one of the devices registered under your Pushover
account. The device will need to have the Pushover iOS or Android app installed to receive the test
message.

6.10 MessageSender Service Status

The MessageSender Service must be running for MessageSender to work.  You can easily check the
status of the service by looking at the status bar.

If the service is running, a green status indicator will be showing.  If the service is not running, a red
status indicator will be displayed.
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If the service is not running when you start MessageSender Manager, a warning message will be
displayed.

6.11 File Location

MessageSender 5 stores a number of important files under the Windows common data folder (eg. C:
\ProgramData\Cybercom Software\MessageSender5).  These files are essential to MessageSender's
operation:

MessageSender.ini
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EmailPhoneMessageTemplate.tem
EmailTextMessageTemplate.tem
SMSPhoneMessageTemplate.tem
SMSTextMessageTemplate.tem

Activity log files are automatically created in this folder, as well as any message templates you create.

6.12 Purchasing MessageSender

You can purchase MessageSender online.  Just click the Purchase button on the Trial Period screen,
or select Purchase from the Help menu.

Ordering online from the Cybercom Software website is completely safe and secure.  Once you have
purchased MessageSender you will receive your license details within a couple of minutes (check your
Spam or Junk Mail folder if you don't receive it).

Click the License button on the Trial Period screen, or select License from the Help menu to license
MessageSender.

There is no need to reinstall MessageSender after purchasing it.  The license information will convert
your existing MessageSender installation from a trial version to a fully licensed version.

Your license details will be displayed on the About screen (click the About button on the toolbar or
select About from the Help menu).

     

6.13 Licensing MessageSender

When you purchase MessageSender you will receive your license details by email.  You can license
MessageSender by clicking the License button on the Trial Period screen, or by selecting License
from the Help menu.
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Enter your license details into the fields as show above, then click the Activate License button.  

MessageSender will connect to the license server over the Internet and download your license and
install it.  A message should be displayed once this has been completed.

7 SMS Gateway Providers

MessageSender can automatically forward PhonePad messages to cell/mobile phones via SMS. 
However, you will need an account with an SMS Gateway Provider.  MessageSender currently
supports these SMS Gateway Providers:

Clickatell - A popular SMS Gateway provider - www.clickatell.com

SMS Global - Another popular SMS Gateway provider - www.smsglobal.com

Pushover - Not really an SMS Gateway provider but it provides a similar service - www.pushover.net 

More providers will be added in future releases.

7.1 SMS Global

SMS Global provide SMS gateway services for most countries via their MXT web messaging platform. It
costs nothing to set up an account with them. It works on a credit system where you purchase the
number of message credits, so you only pay for the SMS messages you send.

Setting Up an Account with SMS Global

1. Go to the SMS Global website: www.smsglobal.com/sign-up

2. Fill in your details to create your account.
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3. If  you are in the US please note that the country will be listed as USA, not United States.

4. Once your account is set up, select Store from the menu on the left.

5. You can purchase some SMS credits by entering a currency amount and clicking the Buy
button, or by selecting a plan.
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6. The cell/mobile number you verified will be used in MessageSender as the Account ID (see
Tools/Verified Numbers).

7. Select Tools/API Keys and add an API Key for HTTP.

8. The Username and Password will be used in the MessageSender settings.
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7.2 Clickatell

Clickatell provide SMS gateway services for most countries via their web messaging platform. It costs
nothing to set up an account with them. It works on a credit system where you purchase the number of
message credits, so you only pay for the SMS messages you send.

Setting Up an Account with Clickatell

1. Go to the Clickatell sign up page: https://www.clickatell.com/register

2. Select Developers' Central.

3. Choose an option appropriate for your country.

4. Complete the details requested.

5. Once you have set up your account, select Set Up a New API from the APIs menu.
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6. Click the Add HTTP API button.

7. Record the API ID.  You will need this for setting up MessageSender.
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7.3 Pushover

Pushover provides an easy way of sending text messages without using an SMS network. Currently you
can send 7500 text messages per month for free with Pushover and MessageSender.

Setting Up an Account with Pushover

1. Go to the Pushover website: www.pushover.net

2. Locate the Login or Signup link.
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1. Once your account has been set up, you will receive a User Key.

     

2. Copy and paste the User Key to the User Key field on the Pushover settings screen in
MessageSender.

3. You will need to register MessageSender as one of your applications. Scroll down until you get to the 
Your Applications section.

4. Click Register an Application.
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5. The Create New Application/Plugin page will be displayed.

6. Under Name, enter MessageSender (1).

7. Select Application as the Type (2).

8. You can enter a Description and/or URL if you want but this is optional (3).

9. If you would like the MessageSender icon displayed in your iOS and/or Android app, click the 
Browse button and navigate to the Icon folder (it's under the MessageSender folder) (4).

10.Check the Terms of Service check box (5).

11.Click the Create Application button (6).

12.An Application Key (API Token/Key) will be created and displayed.
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13.Copy and paste the key into the Application Key field on the Pushover settings screen in
MessageSender.

14.That's it!

You will also need to download the Pushover app to your iOS or Android devices.  They come with a
free 7-day trial and they cost around $5 (USD) to buy.  The great news is you only have to buy them
once for each platform. After that they are free for any other devices on the same platform.

  Pushover iOS app

Pushover Android app

8 Version History

Version 5.15 MessageSender now automatically uses the correct SMTP authentication when
communicating with mail servers.
Removed authentication settings because it is now automatic.
Added support for Pushover.
This version now has a 30 day trial period.
Fixed minor issues.

Version 5.14 Added a Sender ID field for Clickatell. U.S. customers are required by Clickatell to
provide a mobile/cell phone number that they have registered with Clickatell.

Version 5.13 Fixed an issue with Clickatell SMS’s not working due to a parameter change by
Clickatell.
Added an API ID field for Clickatell.
Added a Test button for Clickatell.

Version 5.12 Fixed issue with the MessageSender service not recognizing changed settings until
the service was restarted.  Now it will accept the changes immediately.
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Added option to automatically delete older activity log files.

Version 5.11 Added SMS test message option for SMS Global.
Added check to see if MessageSender service is running.
Added option to override email username and password requirement.

Version 5.10 Added loading and saving of main form size and position.
Added menu options for recreating default message templates.
Added button for validating PhonePad data folder setting.

Version 5.09 Fixed issue with Activity Log.
Fixed screen refresh issue that sometimes occurs on Windows 7 machines.

Version 5.08 Repositioned Delete button.

Version 5.07 Minor Fixes

Version 5.06 Added option for deleting individual queue items.
Added temp folder edit field.
Increased refresh timer.
Fixed display issues.
Expanded activity log messages for processing messages to identify message type
and transport mechanisms.
Blank lines were being added to email recipient lists where there were blank lines
entered in the PhonePad redirection option - FIXED.
Added encoding options to the service for use in the future.  No options were added
to MessageSender Manager.
Added check to make sure that the ForwardQueue table exists.
Improved error trapping.
Added unique error code for each exception.
Fixed issue where email recipients were sometimes not being added correctly.

Version 5.05 Added Test option for testing email authentication settings.
Changed activity log delete button to allow deletion of all logs, or just individual ones.
Added log message to advise user that the MessageSender service must be installed
on the same computer as the database.  This appears if MessageSender can't find
the data folder.
Added check to only clear message queue if messages have been successfully
processed.
MessageSender now checks the response code from the mail server and adds
message to be cleared only if response code 250 is received.
Changed the way recipients are added to emails.
Changed the formatting of some log messages.
Add an activity log message that advises that the MessageSender is not active if it is
not active.

Version 5.04 Added SMTP Authentication methods.
Added Cancel Settings button.

Version 5.03 Minor bug fixes.

Version 5.02 Added MessageSender 5 Share Creator.

Version 5.01 Added AutoRefresh option for Activity Log.
Added AutoRefresh option for Message Queue.
Redesigned Message Queue list.
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Version 5.00 Initial version.
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